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Introduction to Microsoft Excel 2000

Welcome to Microsoft Excel 2000.  This program is designed to make your number
crunching needs easy to accomplish.  Let’s see how this is done.

Screen Layout
 

Title Bar 
Menu Bar 

Tool Bars 

Formula Bar 

Column 
Headings 

Row 
Headings 

Worksheets in the 
Workbook 

Scroll 
Bars 

Status Bar 

Title Bar At the very top of the screen is the Title Bar.  If the
Title Bar is colored, it designates the active
window.  On the left side of the title bar is the
Excel icon.  Double Clicking on the Excel Icon will
exit the program.  On the right side of the title bar
is the minimize button, the maximize or restore
button, and the “X” Exit button.
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Menu The second line is the menu.  Use the mouse to
click on the option desired, or ALT key plus the
underlined character of the option for keyboard
access to the menu.

Toolbars The next two lines are toolbars.   Excel provides 16
different toolbars, although you’ll normally display
only two or three at any one time.  Microsoft’s
“factory settings” display only the Standard and
Formatting toolbars.

You can display any available toolbar by opposite
mouse-clicking on any toolbar displayed on your
screen and selecting the toolbar from the drop-
down menu that appears.

Placing the mouse pointer on the icon brings up a
word description of what the icon does.  The
Toolbars provide a quicker access to functions
normally found in the menu, maybe buried under
several selections.

 You can select or unselect Toolbars by choosing
View, Toolbar, or by clicking on the toolbar with
the opposite mouse button and unselecting, or
selecting from the list.

Formula Bar Displays the contents of the selected cell in the
worksheet.  You can edit the contents of a cell from
the formula bar.

Scroll Bars The Scroll Bars allow quick movement both
Vertically (on the right side of the document
window, and Horizontally (at the bottom of the
document window).  To the left of the horizontal
scroll bars, are the worksheet pages, and to their
left is the icons to move between worksheets.



Introduction to Microsoft Excel 2000 Page 3 June 1999
University of North Texas Computing Center HelpDesk Support Services

Status Bar The bar at the bottom of the screen displays
information about a selected command or an
operation in progress.
• When a command is selected, the left side of the

status bar briefly describes the command.
• The left side of the status bar also indicates

operations in progress, such as opening or
saving a file, copying cells, or recording a
macro.

The right side of the status bar shows whether keys
such as CAPS LOCK, SCROLL LOCK, or NUM
LOCK are turned on.
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Using HELP!!
Help is accessed by selecting Help from the menu bar.  This is done either with
the mouse (point and click) or using the ALT +  H key from the keyboard.  Once
Help is selected, several options appear in the menu:
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Microsoft Excel Help (F1) Office Assistant provides the ability to search for
specific topics or select from options. Or you can
choose to turn off the Office Assistant and Help
would go to Contents and Index.

Contents and Index The Contents section provides a series of mini
topics from which to choose.  The Index shows a
comprehensive list of functions.

What’s This? Point and click at the function you want to know
more about.  A comment box will pop up to tell you
about the item.

Microsoft on the Web Addresses to the World Wide Web for Excel
Information.
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Lotus 1-2-3 Help Additional Help for Lotus Users.

Detect and Repair Feature of Office 2000 to fix problems found in
trying to work with Excel.

About Microsoft Excel About Microsoft Excel has information as to the
version of Excel you are using, and additional
system information.
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Worksheet Basics

Whenever you start Microsoft Excel, a blank workbook opens, ready for you to
work.  This workbook consists of several worksheets in which you can enter and
edit information.  When you start working in Excel, you can either begin working
on the blank workbook that Excel creates, or you can open an existing file.

All new Excel projects start as multi-page books.  This makes it easier to create
related worksheets.  For instance, if you are taking care of several account
numbers, you can have a worksheet for each account, and a top “consolidation
sheet.”

Creating a Worksheet  -  Type the following text and numbers.  Use TAB
to move from column to column.  Use Backspace key if you make a mistake
before pressing enter.

Categories January 1995 February 1995 March 1995
Books 14 20 22
Pencils 30 35 32
Crayolas   4 10   8

• As you start typing, the text will appear in the active cell and in the Formula
bar.  Pressing the Enter key or clicking the checkmark button in the Formula
bar concludes the text entry and places the text in the active cell.

• Press TAB to move to the next cell, or use the arrow keys to move down or
across.

• If you change your mind before you press enter, you can press the ESC key
or click on the X button in the Formula bar to cancel the entry.

• You can type up to 255 characters per cell.  It will only display 10 characters
until the cell is resized.

• After you have entered text, you can easily increase cell sizes later or word-
wrap text to accommodate the entries.

Entering and Editing Data
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Entering Data You can enter three types of information in a cell:
Text
Numbers
Formulas

Normally Row 1 is the column headings.  (Example
above = Categories, Jan99, Feb99, Mar99)

Column A is the row labels.  (Example above =
Categories, Books, Pencils, Crayolas)

The program will format a cell based on the type of
data put in the cell.   Text is left justified. Numbers
are right justified.  Formulas always begin with the =
(equal sign)

Changing Column
Width

Column A is not large enough to fit the information in
cell A1.  To readjust the column width, place the
cursor on the divider line between Column A and B
until the cursor changes to 4 sided arrow.

 

Column Divider Line 

Double click the cursor, and the column will readjust
to the width of the largest number of characters in
column A.

Display Numbers as To change the look of the numbers to be currency,
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Dollars you need to first highlight the columns and then
change the formatting for the cells.

To highlight, click on the Column letter at the top of
the screen for Column B.
The whole column should be highlighted.

Because we are going to change the formatting for all
three columns (B through D),  hold down the mouse
and slide it from B to D on the column letters so all
three columns are highlighted.
 

Hold down mouse button 
and slide across all three 
column letters. 

Once highlighted, select FORMAT, CELLS, and
make sure the NUMBER tab is selected.  Select
Currency, and decide if you want any decimals, or if
you want to use the $ dollar sign.

Even the Date
Changed to

Currency!

We had a slight problem with this.  The column
headings also changed to currency because the date
(January 99, etc.) is stored as a number.  Not a
problem, however.  You can go in and change just the
information on Row 1 to display the date correctly.
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First, highlight Row 1 by clicking the #1 in the left
margin.
Then select FORMAT, CELL, NUMBER, and
DATE.  Pick the date displayed as the abbreviated
month and last 2 digits of the year.

Add the Columns Now that the spreadsheet is formatted to look the way
you want, we need to total each column to see how
much was sold in January, February and March.

Place your cursor in cell B5 to create the formula to
total the column.

To create the formula, you can go the easy way,
by selecting the Sigma icon on the toolbar.  This is a
“wizard” that will anticipate you want to add the
column of numbers above (or to the side if there are
numbers there), and create the =SUM formula for
you.  It will also “box in” the cells to be added.  If
you agree with this, you simply press Enter.
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Copy the Formula to
the other months

You can now take the formula created for January 99
and copy it to the other months.  The easy way to do
this is as follows:
With the cursor in cell B5 (location of the formula), if
you will look in the lower right corner of this cell, you
will see a small box.  Point your mouse on the box,
and hold down the mouse button as you drag over to
column D.  Let go of the mouse and the formula will
copy over.

Find the Average
Dollar Sales for

Books

To find the average monthly sales for Books, you
need to create another formula.  This cannot use the
Sigma icon because you are not just adding.
To create the formula from scratch, move the cursor
to cell E2.
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In Cell E2, type an equal sign = to let the program
know you are going to create a formula.

The formula for Average is as follows:
=AVERAGE
The range of cells you now put in will need to be
surrounded by parentheses, so type the first
parentheses.
You now need to give the program the range of cells
to be averaged, and you can either type in these cells
or use the mouse to highlight the cells.
To use the mouse, move the mouse to cell B2, hold it
down and drag to D2.  You should see the cell
numbers showing up in the formula.  Let go of the
mouse , and type in the end parentheses.  Press enter
to calculate the formula.
The formula should look like this:
=AVERAGE(B2:D2)

 

Copy 
Corner 

To copy the formula to the other two categories, point
your mouse to the small box in the lower right corner
of the cell.  Hold down and drag to cell E4.

Save the file again As often as you remember, save the file.  There is a
shortcut for this on the Standard toolbar.  Click on the
icon that looks like a diskette and it will update the
file.
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Print the File First, look at FILE, PRINT PREVIEW and see if this
is how you want to print the file.

If so, close Print Preview, and select File, Print.  But,
if you would like to change the way it prints by
having gridlines showing, you need to make some
changes first.  So close Print Preview, and  select
FILE, PAGE SETUP, SHEET.

To have gridlines, make sure Gridlines is checked.  If
you’d like to see the column headings (A, B, C) and
the row numbers (1, 2, 3) displayed in the printout,
select Row and Column Headings.

As you can see, you can also change margins and add
a header and/or footer from Page Setup by going to



Introduction to Microsoft Excel 2000 Page 14 June 1999
University of North Texas Computing Center HelpDesk Support Services

the different tabs.  You can also use Print Preview to
see how your changes will affect the look of the
spreadsheet.

When actually ready to print, choose FILE, PRINT
and get the following Print menu.

Under “Print What” you can print just the active sheet
in which you are working, only what you have
highlighted, or the entire workbook.
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Create
Another
Spreadshee
t – Part-
Time
Student
Payroll

Scenario:  You have six student workers who need to be
paid.  In addition to calculating the individual paychecks,
you also need to know what your total outlay for Part-time
payroll is, as well as the total number of hours worked.  To
accomplish this, we will create a workbook that will
include each Month’s payroll details, and a summary sheet
to show the total to date for the fiscal year.

Create a new
Workbook

To create a new workbook, select FILE, NEW, and press
Enter.

The new workbook will have 3 worksheets already created.
We need to label the worksheets something other than
“Sheet 1” “Sheet 2”, etc.

Because the first sheet will be the summary sheet for each
month’s grand totals, we need to rename the sheet to say –
Summary for FY2000 Payroll

To accomplish this, place your mouse on the Sheet 1 tab,
and click the Opposite Mouse Button (right button for right
handed folks, left button for left handed folks).  A special
menu will appear, one item of which is to rename the tab.
Select Rename, and change the name from Sheet 1 to
Summary for FY 2000 Payroll
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Change Sheet 2
Tab

Change the Sheet 2 tab to read – September 1999 Payroll.

Because we are going to be changing the formatting
dramatically for the Detail Payroll Sheet, we will be
copying the contents to a new sheet.  Sheet 3 will not be
used, so we can go ahead and delete it (opposite mouse
click on Sheet 3, and select Delete from the menu).

SAVE THE FILE – Save the workbook with FILE, SAVE,
and name it FY2000 Parttime Payroll

Create Summary
Sheet

Select the Summary sheet tab, and type in label
information.

Cell A1:  Part-Time Payroll for FY 2000

Cell A3:  Month
Cell B3:  Hours Worked
Cell C3:  Total Salary

Cell A4:  September 1999

Automatic List
Once this information is typed in, we can use the automatic
list to create the rest of the months through August 2000.

1. Make sure the cursor is in the September 1999 cell.
2. There should be a small black box in the lower right

corner of the cell when it is highlighted.
3. Place the cursor on that little black box, hold down

the regular mouse button, and keep it down as you
drag the cursor down the column.

4. You should see a tool tip pop up to let you know
when it reaches August 2000.  Let up on the mouse
button, and the list will be automatically completed.

Do the
In Cell A17, put the word TOTALS.



Introduction to Microsoft Excel 2000 Page 18 June 1999
University of North Texas Computing Center HelpDesk Support Services

Housekeeping –
Center Title over
3 Columns, and
Resize the
Columns to fit
data

Center the title in cell A1 between the 3 columns on the
screen.  First highlight cells A1, B1, and C1, by holding
down the mouse in cell A1 and dragging to C1.

Then select the “Merge and Center” command on
the Standard Toolbar

Readjust the columns to proper size by placing the mouse
on the divider line between column A and B labels, and
double click to resize.  Do the same for B and C, and C and
D.

Column
Formatting,
Column Totals,
and SAVE THE
FILE

Column C will be holding Currency, so needs to be
formatted to display as currency.  Click the letter C on the
column heading.  The whole column should highlight.
Select Format, Cell, Number, Currency.

Add the formula to add the column totals, by moving your
cursor to Cell B17 and put in the formula:  =SUM(B4:B15)
Use the same cell logic in Cell C17:
=SUM(C4:C15)

You are now finished with this worksheet until you start
copying data from the monthly worksheets.

SAVE THE FILE!!  You don’t want to have to reenter any
of the formatting, so save the file often.

Create Monthly
Payroll Detail
Sheet for
September 1999

Click the Sheet tab for September 99 Payroll to move to it.
1. Create the title of the spreadsheet by moving to cell

A1 and typing:  Hourly Payroll – September 1999
2. Type the following Column Headings:
3. Cell A3:  Name
4. Cell B3:  Hourly Rate
5. Cell C3:  Hours Worked
6. Cell D3:  Salary Total

The Students names will be entered starting in Cell A4.
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A4:  Ringo Starr
A5:  Paul McCartney
A6:  George Harrison
A7:  Julian Lennon
A8:  Emmitt Smith
A9:  Troy Aikman

Hourly Rates are:
B4:  $10
B5:  $15.45
B6:  $10
B7:  $3.65
B8:  $20
B9:  $20

Hours Worked in September are:
C4:  99.5
C5:  102.6
C6:  88.1
C7:  88.3
C8:  75
C9:  103.1

Enter totals as follows:
A11:  Total Hours Worked
A12:  Total Salary
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Format the
Columns

Column B needs to be formatted for Currency:
1. Click the Letter B above the column to highlight the

entire column.
2. Select FORMAT, CELL, NUMBER, and select

Currency.
3. Select OK to exit.
4. Click the letter C above the column to highlight.
5. Select FORMAT, CELL, NUMBER, Number, and

make sure to change the number of decimals to 1,
and check to use the comma as the 1000 separator.

6. Select OK to exit.
7. Click the letter D above the column to highlight.
8. Select FORMAT, CELL, NUMBER, Currency.
9. Select OK to exit.

Create the
Formula to find
their salaries

In Cell D4, create the formula to calculate the salary.
=ROUND(B4*C4)
and press Enter.

1. Move your cursor back to the cell.
2. Place the mouse on the small black box in the right

corner of the cell.
3. Hold down the mouse button, and drag down 5 rows

to cell C9.

The ROUND part of the formula will make sure the
total is actually what is viewed on the screen.
Otherwise the “stored” number might be 99.46592
instead of the “visual” number of 99.47.  The program
will actually use the 99.46592 when adding the column
or calculating unless you use ROUND.

Total the
Columns

The only columns that need to be totals are Columns C and
D.
In cell C11, type the following formula:
=sum(C4:C9)
In cell C12, type the following formula:
=sum(D4:D9)



Introduction to Microsoft Excel 2000 Page 21 June 1999
University of North Texas Computing Center HelpDesk Support Services

SAVE THE FILE
Save your work, by pressing the Save icon or going to
FILE, SAVE.

Copy the totals to
the Summary
Sheet

To copy these totals to the Summary sheet,
1. First move the cursor to the “Total Hours Worked”

column (C11).  Select EDIT, COPY.
2. Move to the Summary worksheet, by clicking the

sheet tab at the bottom of the worksheets.
3. Move cursor to the cell that will hold the totals hours

worked for the month of September (B4).
4. Click inside the cell, and then do an opposite mouse

click to bring up the alternative menu.  Select
PASTE SPECIAL.

5. When the screen comes up, select PASTE LINK that
is in a box in the lower left of the Paste Special
dialog screen.

6. You should now see the Total from the previous
worksheet.
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Repeat for Total Salary.
1. Go to the September 1999 Payroll worksheet.
2. Move to the Total for Total Salary (D12) and select

EDIT, COPY.
3. Move to Summary Worksheet by clicking the sheet

tab at bottom of worksheet.
4. Move to the cell that will hold the total salary for

September 1999 (C4).
5. Click inside the cell, and then do an opposite mouse

click to bring up the alternative menu.  Select
PASTE SPECIAL.

6. When the screen comes up, select PASTE LINK that
is in a box in the lower left of the Paste Special
dialog screen.

7. You should now see the Total from the previous
worksheet.

SAVE THE FILE.
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Create the
October 1999
worksheet

To copy the contents of the September 1999 worksheet to
another:

1. Point mouse to the Sheet tab at bottom of worksheet
that says September 1999.

2. Opposite mouse click, and select Move or Copy.
3. When the quick menu comes up, make sure you put a

check by the “COPY” box.
4. You want the copy to go after September 1999.
5. Select OK.
6. You will see another sheet that will say September

1999 (2).
7. You will need to rename the (2) copy to October

1999.
8. Change the title line to show October 1999 instead of

September.
9. Delete the number of hours worked by the

individuals.
10. Enter in the new data when you know it, and the

salaries will automatically recalculate.
11. Go through the same steps as above in the “Copy

The Totals to the Summary Sheet” to copy and
“Paste Special” the totals to the summary.

Use the same
steps for
November 1999
and each
successive month

You can either create all the worksheets at this time, or
wait until the new month begins to copy to the new month
so you can include any employee changes or salary
changes.

SAVE OFTEN.
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Printing

To print the workbook, use FILE, PRINT.  When the
menu appears, be sure to select Print entire workbook
to print the Summary and all the months of payroll
detail.  If you only want to print one worksheet, be
sure your cursor is in the worksheet to be printed, and
select the Print icon on the standard toolbar.

Do you want today’s
date showing on the
printout?

If you have some additional information to put in a
header or footer, you can set it up using FILE, PAGE
SETUP.  Use the Header or footer to print the name
of the worksheet, the name of the workbook file,
and/or today’s date.  If you are printing several
variations of the file, you may want to include the
print time of day as well, so you can refer to a specific
printout.
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APPENDIX A

Moving Around in a Worksheet - Selecting Cells
You can select several cells at once by holding down either the Shift or Ctrl key
while you click the mouse.  When you select more than one adjacent cell, you
are selecting a range of cells.  To select several non-adjacent cells, you simple
click the first cell, hold down CTRL, and click the next cell that you want.
TO SELECT DO
Multiple cells Click the first cell in the range.  Hold

down Shift and click last cell in the
range.

Non Adjacent Cells Click on first cell to activate it, then
hold down Ctrl, and click the next
cell to select only those two cells.

Entire Row Click on a row number
Entire Column Click on column’s letter heading
Range of Cells Click and Drag mouse to highlight
Entire Worksheet Click on empty cell in top left corner

above Row 1, and to the left of
Column A

TO SELECT DO
Non Adjacent Rows Click on row number, hold down

Ctrl, and click on a different row
number.

Non Adjacent Columns Click on Column letter, hold down
Ctrl, and click on different column
letter.

Keyboard – select entire row With a cell active in the row, press
Shift + spacebar.

Keyboard – select entire column With a cell active in the column,
press Ctrl + spacebar.

Keyboard – entire worksheet Ctrl + Shift + Spacebar
To extend selections in any direction, hold down the SHIFT key and press the
appropriate arrow key.
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Moving Around in a Cell
TO MOVE PRESS
Left one cell Left Arrow
Right one cell Right Arrow
Up one cell Up Arrow
Down one cell Down Arrow
Up one screen Page Up
Down one screen Page Down
To the first cell in a row that contains data Ctrl + Left Arrow
To the last cell in a row that contains data Ctrl + Right Arrow
To the start of the worksheet Ctrl + Home
To intersection of last row & column containing data Ctrl + End

Keyboard Commands
Function Keys You can use the 12 function keys to access

features.

F1
Shift F1

Alt F1
Alt Shift F1

Display Help or the Office Assistant
What’s This?
Insert a chart sheet
Insert a new worksheet

F2
Shift F2

Alt F2
Alt Shift F2

Edit the active cell
Edit a cell comment
“Save As” command
“Save” command

F3
Shift F3
Ctrl F3

Ctrl Shift F3

Paste a Name into a formula
Paste a function into a formula
Define a name
Create names by using row and column labels

F4
Shift F4
Ctrl F4
Alt F4

Repeat the last action
Repeats the last find (Find Next)
Closes the window
Closes Microsoft Excel
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F5
Shift F5
Ctrl F5

Go To
Display the Find dialog box
Restores window size

F6
Shift F6
Ctrl F6

Ctrl Shift F6

Move  to the next pane
Move to the previous pane
Move to the next workbook window
Move to the  previous window

F7
Ctrl F7

Checks spelling
Move command (document Control menu)

F8
Shift F8
Ctrl F8
Alt F8

Extend a selection
Add to the selection
Resize the window
Display the Macro dialog box

F9
Shift F9
Ctrl F9

Calculates all sheets in all open Workbooks
Calculates the active worksheet
Minimizes the workbook

F10
Shift F10
Ctrl F10

Make the menu bar active
Display a shortcut menu
Maximize or restore  the workbook window

F11
Shift F11
Ctrl F11
Alt F11

Create a chart
Insert a new worksheet
Insert new Microsoft Excel 4.0 macro Sheet
Display Visual Basic Editor

F12
Shift F12
Ctrl F12

Ctrl Shift F12

Save As command
Save command
Open command
Print command

Transition Navigation
Keys

When you choose the Options command from the
Tools menu and select the Transition Navigation
Keys check box on the Transition tab, the
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following keyboard shortcuts are in effect.

Navigation Keys Ctrl + Left Arrow Left one page
Ctrl + Right Arrow Right one page
Ctrl + Page Up In a workbook, next sheet
Ctrl + Page Down In a workbook, prev. sheet
Tab Right one page
Shift + Tab Left one page
Home Selects cell in the upper-left

Corner of the sheet

Function Keys F5 Go To Command
F6 Next window of same workbook
Shift F6 Previous pane of the same window

In Data Find Mode Left Arrow Moves to the previous field of the
current record

Right Arrow Moves to the next field of the
current record

Home Moves to the first record
End Moves to the last record

Text-Alignment Prefix
Characters

‘ (apostrophe) Aligns data in the cell to the left
“ (double quote) Aligns data in the cell to the right
^ (caret) Centers data in the cell
\ (backslash) Repeats characters across the cell

Keys for Windows 95 /
98 / NT

Alt+Tab Switch to the next program
Alt+Shift+Tab Switch to Previous Program
Ctrl+ESC Show the Windows START Menu
Ctrl+W Close the active workbook window
Ctrl+F5 Restore the active workbook window
Ctrl+F6 Switch to next workbook window
Ctrl+Shift+F6 Switch to previous workbook

window
Ctrl+F7 Carry out the MOVE command
Ctrl+F8 Carry out the SIZE command
Ctrl+F9 Minimize the workbook window to an
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icon
Ctrl+F10 Maximize or restore the workbook

window
Alt+0 Select the folder list in the Open or

Save as dialog box (arrow keys to
select a folder)

Alt+number (1 is the leftmost button, 2 is the
next, and so on)  Choose a toolbar
button in the Open or Save As dialog
box (file menu)

F5 Update the files visible in the Open or
Save As dialog box

Format Data by Using
Shortcut Keys

Alt+’ (‘ is the apostrophe) Display the
Style command (format menu)

Ctrl+1 Display the Cells command (format
menu)

Ctrl+Shift+~ Apply the General number
format

Ctrl+Shift+$ Apply the Currency format with
2 decimal places (negative numbers
appear in parenthesis)

Ctrl+Shift+% Apply the Percentage format
with no decimal places

Ctrl+Shift+^ Apply the Exponential number
format with two decimal places

Ctrl+Shift+# Apply the Date format with the
day, month, and year

Ctrl+Shift+@ Apply the Time format with the
hour and minute, and indicate A.M. or
P.M.

Ctrl+Shift+! Apply the Number format with
two decimal places, 1000 separator,
and – for negative values

Ctrl+Shift+& Apply the outline border
Ctrl+Shift+_ Remove all borders
Ctrl+B Apply or remove bold formatting
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Ctrl+I Apply or remove italic formatting
Ctrl+U Apply or remove underline
Ctrl+Shift+( Unhide rows
Ctrl+0 (zero) Hide columns
Ctrl+Shift+) Unhide columns

Work in Cells or the
Formula Bar by using
Shortcut Keys

= (Equal sign) Start a formula
ESC Cancel an entry in the cell or formula

bar
F2 Edit the active cell
Backspace Edit the active cell and then clear it, or

delete the preceding character in the
active cell as you edit the cell contents

F3 Paste a name into a formula
Ctrl+F3 Define a name
F9 Calculate all sheets in all open

workbooks
Shift+F9 Calculate the active worksheet
Alt+= Insert the AutoSum formula
Ctrl+; Enter the date
Ctrl+Shift+: Enter the time
Ctrl+K Enter a hyperlink
ENTER Complete a cell entry
Ctrl+Shift+* Copy the value from the cell

above the active cell into the cell or
the formula bar

Ctrl+’ (‘ is the  single left quotation mark)
Alternate between displaying cell
values and displaying cell formulas

Ctrl+’ (‘ is the apostrophe)  Copy a formula
from the cell above the active cell into
the cell or the formula bar

Ctrl+Shift+Enter Enter a formula as an array
formula

Ctrl+A Display for Formula Palette after you
type a valid function name in a
formula
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Ctrl+Shift+A Insert the argument names and
parentheses for a function, after you
type a valid function name in a
formula

Alt+Down Arrow Display the AutoComplete list

Enter Data by Using
Shortcut Keys

ENTER Complete a cell entry
ESC Cancel a cell entry
F4 or Ctrl+Y Repeat the last action
Alt+Enter Start a new line in the same cell
Backspace Delete the character to the left of the

insertion point, or delete the selection
Delete Delete the character to the right of the

insertion point, or delete the selection
Ctrl+DeleteDelete text to the end of the line
Arrow Keys Move one character up, down,

left or right
HOME Move to the beginning of the line
Shift+F2 Edit a cell comment
Ctrl+Shift+F3 Create names from row and

column labels
Ctrl+D Fill down
Ctrl+R Fill to the right
Ctrl+Enter Fill the selected cell range with the

current entry
Enter Complete a cell entry and move down

in the selection
Shift+Enter Complete a cell entry and move up in

the selection
Tab Complete a cell entry and move to the

right in the selection
Shift+Tab Complete a cell entry and move to the

left in the selection

Using Page Setup Change the Look of the Worksheet
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Page Setup Use the Page Setup command located on the File
menu to get the right look for your printout.

Page Change Page orientation, size,  and scaling.

Margins Change margins for the entire page, for headers
and footer locations, and centering horizontally or
vertically on the page.

Header/Footers Create Headers and Footers.
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Sheet Set up printing options, such as printing row titles
and column titles, using gridlines, and page order
to print when there are more columns than will fit
on the page.
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Different Ways to Save a Workbook

Saving the Workbook Save the file with the name “Jan-March 1999 Inventory” by
selecting FILE, SAVE, and typing the file name. Type up to
255 characters in a file name.  Press Enter or select OK.

File, Save FILE, SAVE is used the first time you save the file, and
anytime you want to save all the changes you are making.
The Ctrl+S keyboard shortcut is a convenient way to
save without visiting the File menu.

File, Save As FILE, SAVE AS is used when you want to save the
existing file, but with a different name or file TYPE.
To change the file Type, click the icon after Save As
Type: to see the different types.  These include Lotus,
dBase, MS-DOS text, Quattro Pro, Excel 4, 3, 2, 1
version, etc.  When saved as MS-DOS text, it is in
ASCII format and can be read by any package.
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Save as Web Page Use this procedure to put a worksheet on a Web page so
that others can interact with the data. You can also put a
worksheet on a Web page so that others can only view
the data.
Before you save or publish data on a Web page, save
your workbook as an .xls file so that you have a version
you can modify if you want to later change your Web
page.
Click the worksheet you want to put on a Web page.

1. On the File menu, click Save as Web Page.

2. Click Publish.

3. Make sure that Items on sheetname is selected in
the Choose box and Sheet   All contents of
sheetname is selected in the list.

4. Under Viewing options, select the Add
interactivity with check box, and click the type of
functionality you want for your worksheet.

5. To add a title to the published worksheet, click
Change, type the title you want, and click OK.

6. In the File name box, click Browse, and locate
the drive, folder, Web folder, Web server, or FTP
location where you want to save or publish your
Web page.

7. If you want to view the Web page in your browser
after you publish it, select the Open published
Web page in browser check box.

8. Click Publish.

• If you select a worksheet that contains a chart and
publish it with interactive functionality, the chart
will not be included on the Web page. To put an
interactive chart on a Web page, you must save it
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separately.

• Some formatting and features of your worksheet
are not retained when you save it as a Web page.

• After you save your worksheet as a Web page,
you can't open and modify the .htm file in
Microsoft Excel without losing formatting and
functionality. Use Microsoft FrontPage 2000 or
data access page Design view in Microsoft Access
2000 to modify the Web page.

Save Workspace You can save a group of workbooks in a customized
workspace.  You can open a group of workbooks in one
step by creating a workspace file. A workspace file saves
information about all open workbooks, such as their
locations, window sizes, and screen positions.

When you open a workspace file by using the Open
command (File menu), Microsoft Excel opens each
workbook saved in the workspace. The workspace file
does not contain the workbooks themselves, and you
must continue to save changes you make to the individual
workbooks.

1. Open the workbooks you want to open as a group.

2. Size and position the workbook windows as you
want them to appear the next time you use the
workbooks.

3. On the File menu, click Save Workspace.

4. In the File name box, enter a name for the
workspace file.

Tip   To open the workbooks each time you start
Microsoft Excel, save the workspace file in the XLStart
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folder in your Excel folder. Save only the workspace file,
not the workbook files, in the XLStart folder.

File Names Type a name for your document in the File Name: box,
then simply click the Save button.

Names can be up to 255 characters including spaces.

Print Options

Printing a Worksheet Printing is handled through the File menu.
Select File, Print, OK.

To Preview on the screen before printing:
Select File, Print Preview.  When finished
previewing, select CLOSE
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Changing the Format of Cells, Rows, Columns, Sheets

Formatting the Cell To change the appearance of the information in the
cell, use FORMAT, CELL (or press Ctrl-1).  You
then have several subgroups to choose from.  The
first one is Number, then Alignment, Font, Border,
Patterns,  and Protection.

Format, Cell, Number Choose from the categories shown to display the
numbers in the cell (or range of cells).

 
Each different category will have check-off
information.  The Number category above needs to
know how many decimal places, and if you want to
use the comma as the 1000 separator.  Choose from
the list how you want negative numbers displayed.

The currency category would need to know if you
want to use the dollar sign, and how to handle
negatives etc.
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Format, Cell, Alignment Choose from the types shown for Horizontal
alignment, vertical alignment, and Orientation.  You
can also choose Text Control to wrap text within the
cell.

The default alignment is general which aligns text to
the left, numbers to the right, and centers logical and
error values.

This is also where you would choose to wrap text
within a cell, and to merge cells together.
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Format, Cell, Font Select the font, the style of the font, the size, whether
or not to use underlines and underline style, color,
any special effects.

Format, Cell, Border How do you want the border to look, on which sides
do you want a border, do you want a different color?

Format, Cell, Patterns Changes the pattern and pattern color of a selected
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cell.

Format, Cell, Protection You can select for the cell to be locked, but it will
have no effect unless the worksheet is protected
using Tools, Protection, Protect Sheet.
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Format, Row Purpose is to adjust row height, and hide or unhide
rows.

• You need to select only one cell in a row to
change the height for the entire row.

• To change the height of all rows in a worksheet,
select the entire worksheet.

• Double-click the bottom border of the row
heading to adjust the row height for the best fit.

• The commands on the submenu are not available
if the sheet is protected.

The Row Height can be a number from 0 to 409
representing the row height in points.  If set to 0, the
row is hidden.

The AutoFit command returns each row in the
selection to the standard height within the row.  The
standard height for a row varies according to font
size.

Format Column Adjusts column width, and hides or unhides columns.
• You need to select only one cell in a column to

change the width of the entire column.
• To change the width of all columns in a

worksheet, select the entire worksheet.
• Double-click the right border of the column

heading to quickly adjust the column width for the
best fit.
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• The commands on the submenu are not available
if the sheet is protected.

Width Command - Displays the Column Width
dialog box.  You can enter a number from 0 through
255 in the Column Width box.  This number
represents the number of characters that can be
displayed in a cell using the standard font.

AutoFit Selection - Sets the column to the minimum
width necessary to display the contents of the
selected cells.  If you change the cell contents later,
you must fit the selection again.

Format Sheet Allows you to rename the sheets in a workbook, hide
or unhide them from view.

Format, AutoFormat AutoFormat has a series of existing codes ready to
be applied to your data sheet.  First select the portion
of the sheet, or the entire sheet to be affected by the
codes, then choose FORMAT, AUTOFORMAT and
select of the list provided.  Additional options allow
you to turn on or off certain factions, like changing
the font, the patterns, etc.
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Conditional Formatting Highlight data that meets conditions you
specify

To highlight formula results or other cell values that
you want to monitor, you can identify the cells by
applying conditional formats.

For example, suppose a cell contains a formula that
calculates the variance between forecast sales and
actual sales. Microsoft Excel can apply green
shading to the cell if the sales exceed forecast and
red shading if sales fall short. If the value of the cell
changes and no longer meets the specified condition,
Microsoft Excel temporarily suppresses the formats
highlighting that condition.

Conditional formats remain applied to the cells until
you remove them, even though none of the
conditions are met and the specified cell formats are
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not displayed.

Format, Styles A style can be applied to a cell, range of cells, or the
entire selected worksheet by choosing the
combination of formats you want and assigning them
a name.  You can redefine a style by changing the
formatting characteristics.  Cells formatted with the
style are automatically updated to reflect the new
formats.

The types of formats you can include in a style are
number, font, alignment, border, patterns, and
protection.

If you select Modify, the Format Cells dialog box is
displayed so you can select the formats you want to
use in a style.

Alt + ‘ (Apostrophe) activates the Style box.
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Miscellaneous Commands

Deleting Text Press Backspace key immediately after typing
character.
Select character or text, and press Delete.
Use Edit, Delete to bring up the Delete dialog box.

• If you delete an entire row or column, rows or
columns are shifted to fill the space.

• If you select less than an entire row or column, a
dialog box appears asking whether to shift the
surrounding cells up or to the left, or to delete the
entire column or row.

• A worksheet formula containing a reference to a
deleted cell displays the #REF! value.

• If you press Shift + click Delete button, it
functions the same as the Insert button.

• If you press Shift+click Delete Column button, it
functions the same as the Insert Column button.

• If you press Shift + click Delete Row button, it
functions the same as the Insert Row button.

• To remove the contents (formulas and data),
formats, notes, or all three from selected cells, but
not the cells themselves, use the CLEAR
command.

Undo There are three ways to Undo.
1. Edit, Undo reverses your last action.  Choose

Edit, Undo again to reverse the action before that,
and so on.

2. If you press Ctrl + Z repeatedly, it will reverse
previous actions.

3. The Undo toolbar button and its associated drop-
down list menu let you undo multiple actions in
sequence.
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The exact name of the Undo choice on the Edit menu
changes as you work.  It remembers which steps you
last took, and so can sometimes say Undo Typing,
Undo the cut., etc.  Can’t Undo appears on the Edit
menu if you cannot undo the previous action.

Immediately after you undo an action, this command
changes to Redo.

Shortcut Key:  Ctrl + Z
Alt + Backspace

Redo Use the Redo command to undo an Undo.  To redo
your last action only, choose Edit, Redo.

Replacing Text Combine the steps of deleting unwanted text,
positioning the insertion point, and inserting
replacement text.

1. Highlight the unwanted text.
2. Start typing.

The old text disappears, and the new text snakes
across the screen as you type.
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APPENDIX B

Worksheet Formulas and Functions

Worksheet formulas are tools used in cells to calculate results.

How Formulas Calculate
Values

A formula is an equation that analyzes data on a
worksheet. Formulas perform operations such as
addition, multiplication, and comparison on
worksheet values; they can also combine values.

The formula will always begin with the equal sign
(=).  As soon as the equal sign is recognized by the
program, the formula bar will allow you to look at
the formula wizard.

 

Formula Bar 

Formula List 

Formulas can refer to other cells on the same
worksheet, cells on other sheets in the same
workbook, or cells on sheets in other workbooks.



Introduction to Microsoft Excel 2000 Page 49 June 1999
University of North Texas Computing Center HelpDesk Support Services

The following example finds the average number of
books sold each month.
=average(B2:D2)
Totals the range of cells starting in B2 and ending in
D2, and averages the total by the number of cells.

If you wanted to add these numbers you would
change the formula to read:
=sum(B2:D2)
would add the contents of the three cells.

=max(B2:D2)
would find the cell with the highest value and return
that value.

Formulas can definitely get more complicated than
this, for example:
=(B2+25)/SUM(B4:D4)
=  denotes a formula
B2  is a cell reference
+   is the Addition Operator
25 Is a Numeric Constant
/  is a Division Operator
SUM(B4:D4)  is a Worksheet Function
B4:D4  is a Range Reference
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Formula Syntax Formulas calculate values in a specific order that is
known as the syntax. The syntax of the formula
describes the process of the calculation.

A formula in Microsoft Excel begins with an equal
sign (=), followed by what the formula calculates.
For example, the following formula subtracts 1 from
5. The result of the formula is then displayed in the
cell.
=5-1

Calculation Operators in
Formulas

Operators specify the type of calculation that you
want to perform on the elements of a formula.
Microsoft Excel includes four different types of
calculation operators: arithmetic, comparison, text,
and reference.

Arithmetic Operators Arithmetic operators perform basic mathematical
operations such as addition, subtraction, or
multiplication; combine numbers; and produce
numeric results.

Arithmetic
operator Meaning Example
+ (plus sign) Addition 3+3
– (minus sign) Subtraction 3–1

Negation –1
* (asterisk) Multiplication 3*3
/ (forward slash) Division 3/3
% (percent sign) Percent 20%
 ^ (caret) Exponentiation 3^2

(the same as 3*3)
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Comparison Operators Comparison operators compare two values and then
produce the logical value TRUE or FALSE.

Comparison
operator Meaning Example
= (equal sign) Equal to A1=B1
> (greater than sign) Greater than A1>B1
< (less than sign) Less than A1<B1
>= (greater than or equal to sign)

Greater than or equal to A1>=B1
<= (less than or equal to sign)

Less than or equal to A1<=B1
<> (not equal to sign) Not equal to A1<>B1

Text Operator The text operator "&" combines one or more text
values to produce a single piece of text.
Text operator & (ampersand)
Meaning Connects, or concatenates, two
values to produce one continuous text value
Example "North"&"wind" produce "Northwind"

Reference Operators Reference operators combine ranges of cells for
calculations.
Reference Operator
: (colon)
Meaning:  Range operator, which produces one
reference to all the cells between two references,
including the two references, Ex: B5:B15
, (comma)
Meaning:  Union operator, which combines multiple
references into one reference, Ex:
SUM(B5:B15,D5:D15)
  (single space)
Meaning:  Intersection operator, which produces
one reference to cells common to two references,
Ex:  SUM(B5:B15 A7:D7)
In this example, cell B7 is common to both ranges.
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Using Cell and Range
References

A reference identifies a cell or a range of cells on a
worksheet and tells Microsoft Excel where to look
for the values or data you want to use in a formula.

With references, you can use data contained in
different parts of a worksheet in one formula or use
the value from one cell in several formulas.

You can also refer to cells on other sheets in the
same workbook, to other workbooks, and to data in
other programs. References to cells in other
workbooks are called external references.
References to data in other programs are called
remote references.

By default, Microsoft Excel uses the A1 reference
style, which labels columns with letters (A through
IV, for a total of 256 columns) and labels rows with
numbers (1 through 65,536).

To refer to a cell, enter the column letter followed by
the row number. For example, D50 refers to the cell
at the intersection of column D and row 50. To refer
to a range of cells, enter the reference for the cell in
the upper-left corner of the range, a colon (:), and
then the reference to the cell in the lower-right corner
of the range. The following are examples of
references.
To refer to Use
The cell in column A and row 10 A10
The range of cells in column A and
rows 10 through 20 A10:A20
The range of cells in row 15 and
columns B through E B15:E15
All cells in row 5 5:5
All cells in rows 5 through 10 5:10
All cells in column H H:H
All cells in columns H through J H:J
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Depending on the task you want to perform in
Microsoft Excel, you can use either relative cell
references, which are references to cells relative to
the position of the formula (D11), or absolute
references ($D$11), which are cell references that
always refer to cells in a specific location.

You can use the labels of columns and rows on a
worksheet to refer to the cells within those columns
and rows, or you can create descriptive names to
represent cells, ranges of cells, formulas, or
constant values.

Overview of Error
Values

Microsoft Excel displays an error value in a cell
when the formula for that cell cannot be calculated
properly.  If a formula includes a reference to a cell
that contains an error value, that formula also
produces an error value (unless you are using the
special worksheet functions ISERR, ISERROR, or
ISNA, which look for error values).  You may have
to trace the references back through a series of cells
to discover the source of the error.
Error Value Meaning
########    Not an error – the column is too small.

Need to resize the column.
#DIV/0! The formula is trying to divide by zero.
#N/A No value is available.  Usually, you

enter this value directly into worksheet
cells that will eventually contain data
that is not yet available.  Formulas
referring to those cells will return #N/A
instead of calculating a value.

#NAME? Excel does not recognize a name used
in the formula.

#NULL! You specified an intersection of two
areas that do not intersect.

#NUM! There is a problem with a number.
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#REF! The formula refers to a cell that is not
valid.

#VALUE! An argument or operand is of the 
wrong  type.

Using the Formula
Palette

When you create a formula that contains a function,
the Formula Palette helps you enter worksheet
functions.
As you enter a function into the formula, the Formula
Palette displays the name of the function, each of its
arguments, a description of the function and each
argument, the current result of the function, and the
current result of the entire formula. To display the
Formula Palette, click  the = (equal sign) Edit
Formula in the formula bar.

You can use the Formula Palette to edit functions in
formulas. Select a cell that contains a formula, and
then click Edit Formula (=) to display the Formula
Palette. The first function in the formula and each of
its arguments are displayed in the palette. You can
edit the first function or edit another function in the
same formula by clicking in the formula bar
anywhere within the function.
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Using Functions to
Calculate Values

Functions are predefined formulas that perform
calculations by using specific values, called
arguments, in a particular order, called the syntax.

For example, the SUM function adds values or
ranges of cells, and the PMT function calculates the
loan payments based on an interest rate, the length of
the loan, and the principal amount of the loan.

Arguments can be numbers, text, logical values such
as TRUE or FALSE, arrays, error values such as
#N/A, or cell references. The argument you
designate must produce a valid value for that
argument. Arguments can also be constants,
formulas, or other functions.

=SUM(A10,B5:B10,50,37)

The syntax of a function begins with the function
name, followed by an opening parenthesis, the
arguments for the function separated by commas, and
a closing parenthesis. If the function starts a formula,
type an equal sign (=) before the function name.
As you create a formula that contains a function, the
Formula Palette will assist you .

Using the Formula
Palette to Enter and Edit
Formulas

When you create a formula that contains a function,
the Formula Palette helps you enter worksheet
functions. As you enter a function into the formula,
the Formula Palette displays the name of the
function, each of its arguments, a description of the
function and each argument, the current result of the
function, and the current result of the entire formula.
To display the Formula Palette, click = in the formula
bar.  An alternative way to start the Formula Palette,
from the Insert Menu, choose Function.
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You can use the Formula Palette to edit functions in
formulas. Select a cell that contains a formula, and
then click = to display the Formula Palette. The first
function in the formula and each of its arguments are
displayed in the palette. You can edit the first
function or edit another function in the same formula
by clicking in the formula bar anywhere within the
function. Worksheet functions are calculation tools
that can be used on worksheets to perform decision-
making, action-taking, and value-returning operations
automatically.

The functions are listed by category, such as
“Financial”, “Math & Trig”, or “Statistical”.  When
you select a function from the list box, the definition
of the function and of its arguments will
automatically appear for you, as well as the correct
placement of commas and parentheses.

Types of Arguments Arguments are the information that a function uses to
produce a new value or perform an action.
Arguments are always located to the right of the
function name and are enclosed in parentheses.
Most arguments are expected to be of a certain data
type.

Arguments to a function can be any of the following:
• Numbers - examples are 5.003, 0, 150,266, and -

30.05.  Numbers without decimals are called
integers.  Numbers are accurate to 15 digits.

• Text - Text values used in formulas must be
enclosed in double quotation marks.  Text values
can be a maximum of 255 characters long
including quotation marks.  A text constant that
contains no characters is written as “” and is
called “empty text.”
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• Logical values - The logical values are TRUE and
FALSE.  Logical arguments can also be
statements that evaluate to TRUE or FALSE.

• Error values - Examples of error values are
#DIV/0!, #N/A, #NAME?, #NULL!, #NUM!,
#REF!, and #VALUE!.

• References - References can refer to single cells,
ranges, or multiple selections, and can be relative,
absolute, or mixed.  Examples are $A$10, A10,
A$10, R1C2, or R[10]C[-10].

• Arrays - Arrays allow you to customize how
arguments and functions are entered in cells.


